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The Basics

The keyboard controls the cursor. The mouse controls
the pointer.

Word is a page-oriented word-processing program.
This means the program automatically determines
where a new page begins, and leaves room for the
top, bottom, left, and right margins. The preset (“default”) settings are paper size of 8½ by 11 inches, with
top and bottom margins of 1 inch, and left and right
margins of 1 inch. Once Word is on your screen, you
are ready to type. No layout, format, or design instruction is necessary to begin. If you wish to change
the settings, do so before you type, as you type, or
after you type.

The Keyboard

Concepts to Remember
When working with any computer word processing
program, you should not hit Enter (Return) at the end
of every line. MS Word automatically wraps text that
doesn't fit on one line onto the next line. Only at the
end of paragraphs and where blank lines are desired
should you insert returns. “Word wraps” automatically change whenever your text changes; hard returns must be manually removed using Delete or
Backspace.
When users initially start working with a computer,
they often confuse their cursor with their pointer. The
cursor represents the keyboard—it’s the straight
blinking line that types.

The pointer represents your mouse—it clicks. As you
work in Word, you will see your pointer change
shape; sometimes it is a left-pointing arrow (when
you are at the top of the screen), or it becomes a
right-pointing arrow (when you are at the left of the
screen), or it becomes an “I” shape (the “insertion
point”) when you are in the middle of text.
•
•
•

The left-pointing  mouse arrow gives commands by clicking on buttons or menus (such
as bold or underline or print or save).
The right-pointing  arrow makes selections
(highlights) in the body of your document.
The I-shape inserts your cursor for typing
(the mouse does not type, but it does move
your cursor for you).
1
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Many keys on the keyboard have purposes specific to
Word. The keyboard consists of four components: the
alphanumeric keys (like a typewriter), the cursor
movement keys (the arrows) and accompanying key
operations, the numeric keypad (looks like a calculator), and the function keys (usually across the top, or
connected to the FN key on a laptop).
•
•

•

•

The alphanumeric keypad is the “typewriter.” Important keys include Enter, Shift,
Tab, and Backspace.
The cursor keypad is for moving around
without using the mouse. Important keys include the “cursor arrows” (up, down, left,
right), which move one space or one line at
a time; PageUp and PageDown (move one
screen at a time); Home (beginning of line)
and End (end of line); and Delete (erase).
The numeric keypad is designed for typing
numbers for easily; it only works for numbers if the NumLock key is “on.” If NumLock
is off, the numeric keypad duplicates the cursor keypad. Important keys include + (add), (subtract), * (multiply), and / (divide), all
more commonly used in Excel.
The function keys are shortcuts. F1 is “help.”
F5 is the “Go To” command (to jump to a particular page). F10 is the “Ribbon” command
(turns on Ribbon shortcuts). F12 is “Save As.”

The Screen
At the bottom of the screen is the status line, which
shows your location in the document. As the cursor
moves (either by typing, by using the arrow keys, or
by clicking the mouse), the status line changes to reflect the position.
At the bottom left of the screen is the status line
showing page, page count, word count, and more.
Use your right clicker on the mouse to expand the options (such as “Track Changes” or “Section”. Click on
the page count (“page 1 of 1” in the sample below) to
access a navigation screen for moving from page to
page within the document. Click on the word count
for detailed document statistics. Click on the book
symbol for spell check (“proofing errors”).

In the lower right corner are “View” buttons (Read,
Print, Web) and zoom in/out (enlarge/shrink on
screen) features.

At the right side of the screen is a vertical scroll bar
for moving up and down. Moving with the scroll bar
does not move the cursor location (i.e., you’re not
there until you click on it). The scroll bars can be used
three different ways. You can click on the top or bottom arrows to move line by line, you can pull the box
(“elevator”) on the bar to go to the top or bottom of
the document, or you can click on the blank area to
move screen-up or screen-down (or left or right when
you have a bottom scrollbar on a wide document).
The top of the screen is divided into two parts: the
quick access toolbar and the Ribbon.
The top line, usually in the upper left corner, is the
quick access toolbar and shows you commonly used
operations such as save and open. Use the drop-down
at the end to add and remove additional selections
and to arrange the order of the buttons.

The Ribbon
Below the quick access toolbar is the Ribbon, which is
divided into “tabs” of choices. The tabs show you
“buttons” for various commands, separated into
“groups” (such as Font or Paragraph). In the corner of
some groups, you may see a little boxed arrow, which
opens a dialog window with more options.

To use a tab or a command, click it once with the
mouse pointer. For example, to turn on bold, point
the mouse arrow at it and click the center of the “B.”
To turn it off, click the “B” again. Some buttons have
“drop-downs” with choices, indicated by a downward
pointing arrow; click the arrow for additional options.
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All Ribbons commands are single clicks. If you doubleclick the Ribbon, the Ribbon minimizes. It will reappear if you point at it, but then will disappear again
when you click back in your text. Double-click any tab
to re-open the Ribbon.
The Ribbon can also be accessed from the keyboard,
by pressing the Alt key (next to the spacebar). Alt
turns on the Ribbon keystroke shortcuts. For example, press the letter “P” to go to Page Layout.

Another important screen option (which must be
turned on) is the ruler bar, located under the “View”
tab on the Ribbon. The ruler appears just beneath the
Ribbon, and shows tabs, indents, and margins—and
allows you to change them.

If you highlight (select) an area of text, you will see a
faint shadow Ribbon appear. Move your mouse toward it to makes it more “solid.” This is a shortcut
toolbar for commonly used formats, such as font,
size, bold, italics, and underline.

Highlighting Text with the Mouse
In order to format portions of text, or to do commands such as “cut and paste” (move text), you often
must select the text to be edited. In order to select a
particular area of text, you can use your mouse or
your keyboard to “highlight” it. The basic mouse command to highlight is called point, click, and drag the
mouse. Don't let go of the mouse button until you get
exactly what you want highlighted (if you release the
button and then need to change what you selected,
you have to re-make the selection). When finished
with a highlighted area, you need to stop the highlight, by clicking anywhere in your text to stop the
highlight. Highlights can be made with the following
mouse commands:
•
•
•
•
•
•
•
•
•

•

Click — Position the cursor (I-shape) for typing.
Click, Hold, and Drag — Position cursor and
then highlight; drag down (not over) to move
from line to line.
Double click—Point at a word and click twice
to highlight the entire word.
Triple click—Point at any word and click
three times to highlight the entire paragraph.
Click in Left Margin—Line highlight. (Be sure
the mouse symbol is a right-pointing arrow.)
Double Click in Left Margin—Paragraph highlight.
Triple Click in Left Margin—Document
(global) highlight.
Ctrl Click—Select sentence.
Shift Click—“Range extend.” First, position
your cursor at the beginning of what you
wish to highlight. Then, point at the end of
the desired highlight area, hold the shift key,
and click. Everything from cursor to the
point-position is highlighted.
Alt+Shift Click—Create a block (useful for
tabular columns).

Highlighting Text with the Keyboard
To highlight with the keyboard, hold the shift key and
use your cursor arrows to move around. As you move
with the arrows, the text is highlighted. To undo the
highlight, let go of the shift key and move with any
cursor arrow.
An alternative way to highlight with the mouse is to
click to position your cursor, hold the shift key and
3

click at a second area of the screen. Everything in between will be highlighted for you.
•
•
•
•
•
•

Shift-Arrow — Highlight text
Control-Shift-Arrow — Highlight text word
by word
Shift-Home — Highlight to beginning of line
Shift-End — Highlight to end of line
Ctrl-Shift-Home — Highlight to top of document from cursor
Ctrl-Shift-End — Highlight to end of document from cursor

Inserting and Removing Text
To type new text into text already typed, the most important rule is to position your cursor exactly at the
point where the new text goes. Remember: the
mouse is not the cursor. Once your cursor is positioned, start typing. All existing text adjusts to make
room for the new content (word wrap).
There are three ways to remove text. Delete removes
text following your cursor. Backspace removes text
backwards from your cursor. If text is highlighted,
pressing any key that types will delete whatever is
highlighted.
One option you can activate on your status bar (bottom left) is the button called “Overtype” (use the
right-click on the mouse to see the status bar options). Overtype puts a command on the status bar
called “Insert.” If you click on Insert, it switches to
“Overtype.” Then, when you type, your new text
erases already existing type, so that it doesn’t need to
be deleted.

Changing Default Settings
In Word 2013 (and prior versions), some of the default or built-in settings for Word probably need to be
changed. Some are easily changed, others are trickier.
Font: On the Ribbon “Home” tab, there is a Font
group. In the bottom right corner is a dropdown to
provide additional font options. When you are in the
Font dialog window, select your preferred font and
size, and then click the “Default” button at the bottom of the screen. Word will ask if you would like to
update your “normal” settings (“yes”).
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Spacing: On the Ribbon “Home” tab, there is a Paragraph group. In the bottom right corner is a
dropdown for paragraph options. Most people prefer
to change the default settings for two items on this
screen: line spacing and paragraph spacing (spacing
between paragraphs):
Spacing After: 0
Line Spacing: Single
When finished, again remember to select “Default” at
the bottom and change your “normal.”
Tip: If you find these default changes do not hold, try
making your changes through the “Normal” style (see
page 13).
Other Defaults: Many other key defaults are located
under the “File” tab on the Ribbon, on the “Options”
choice. Some important choices that usually need to
be adjusted include these:
Proofing:
Autocorrect options
Automatically capitalize beginning
of sentences (off)
Set left and first indents with tabs
and backspaces (off)
Advanced:
When selecting, automatically select entire word (on)
Note that File/Options is also where you find the Microsoft Trust Center settings, which control how
downloaded files are opened (in safe mode or in normal mode).

File
Info—File information, such as properties (pages,
word, editing time, date created, author), as well as
commands to convert (for compatibility with other
versions and programs), protect (keep users from
making changes), inspect (identify metadata or
tracked changes you might want to strip out before
sharing), and manage versions (keep multiple versions of the same document, so you can revert to old
versions).

4
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New—“New” starts a document, based on a Microsoft template. The automatic template is the one
called “Blank document.” But there are many other
templates to select from, and at the top of the screen
is a search box for finding more templates online.
If you are already working on a document, “New”
does not remove it or close it from the screen. The
first document goes into a window (workspace), and
the new document goes into a new window.
Open—“Open” retrieves a document from a disk.
When selected, you can choose from recently used
documents, documents stored online (OneDrive or
Other Web Locations), or in some folder or drive or
disk on your computer (such as the Desktop or a USB
Flash drive).
“Save“ and “Save as”—”Save” stores the current document in the “2013” format, asking for a filename
that can be up to 256 characters in length (automatically adding a 4-character extension, “.DOCX”). If the
document has already been saved, pressing “save”
simply resaves it with no questions asked.
“Save as” allows you to re-save an already-saved document under a different name (change the filename)
or in a different location (such as on a Flash drive),
creating a copy. It also gives you an option to specify
the file format (such as “97-03” or “Rich Text Format”).
TIP: Note that one of the big changes in Office
2013/365 is what happens when you click on Save or
Save As. You must first choose your location—do you
want to save on OneDrive (cloud), elsewhere on the
web, on your computer, or somewhere else? Once a
location has been selected, you then have options for
assigning a name and choosing a folder or drive.
Save as Adobe PDF—Convert your document into
Adobe’s Portable Document Format, for viewing,
printing, and commenting using the Adobe Acrobat
Reader.
Print—Print settings, as well as print preview and
page layout.
Share—Email or share your document (such as with
SharePoint or online). Also save as PDF.

Export—Send to Adobe PDF, Create PDF/XPS Document; or Change File Type (save as something other
than Word 2013). According to Microsoft, “An XML
Paper Specification (XPS) document is a document
format you can use to view, save, share, digitally sign,
and protect your document’s content. An XPS document is like an electronic sheet of paper: You can’t
change the content on a piece of paper after you print
it, and you can’t edit the contents of an XPS document
after you save it in the XPS format. In this version of
Windows, you can create an XPS document in any
program you can print from, but you can only view,
sign, and set permissions for XPS documents in an XPS
Viewer [such as the one included with Windows 7].”
(windows.microsoft.com/en-us/windows/xps-documentsfaq#1TC-windows-7).

“Close”—Exit the window that is currently open. If
only one window (document) is open, it also closes
the program (quits Word). If your document has not
been saved, it will prompt you to save your work before closing.
Account—Information about your Microsoft Office
account and user information. “Manage Account”
takes you online to Microsoft. “Connected Services”
show you any additional server or storage access you
might have (such as the Microsoft cloud OneDrive).
Options—All the settings for how Word operates (see
Changing Default Settings on page 3).
Recent—Recently used documents.

Viewing Your Document
The “View” toolbar (lower right corner) gives you
three different ways to look at your document:
•
•

•

Print Layout—Recommended (and the default). What you see is what you get.
Reading Layout—The Reader’s Digest approach, big print, small pages, to make the
document easier to read (has no impact on
printing). Use the arrows at the left and right
edges of the screen to move from page to
page.
Web layout—Converts a normal Word document into an HTML web page.
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On the View tab on the Ribbon are additional options,
including
•

•

Outline—For typing outlines. This adds a
new tab to the Ribbon for Outlining, with
buttons for Promote and Demote (change
levels within the outline). Use the “Close
Outline View” button when done with the
Outline, so you can see how it is formatted.
Draft—You don't see the page margins or
page breaks or much of the formatting. Useful for editing content, when you aren’t concerned with formatting.

There are additional options on the View tab for
working with your document. There are sections for:
•
•
•

Show—Ruler, Gridlines, Navigation Pane.
Zoom—One Page, Multiple Pages, Page
width, Custom Zoom.
Window—View Side by Side (for two documents), Arrange All (for multiple documents), and Split (see two parts of the document at the same time).

On the Quick Access toolbar (top left) is “Print Preview.”

Moving Text
The basic way to move text within a document involves an operation called cut-and-paste, located under the Home tab. To move text or other content, first
highlight it, then use the button called “Cut” (scissors), which will remove your content from the screen
(sending it to the Windows clipboard); alternatively,
use “Copy” (double sheet of paper) to make a copy of
the text while leaving the original in place.
Then, move your cursor to where you would like to
have the cut/copied content to be placed. Use
“Paste” (clipboard) to put the text back into your document. All following text will move down to leave
room for it.
Only one section of cut or copied text can be active at
any one time. When cut (or copied), content is stored
in the Windows clipboard (not in Word), which means
it can then be pasted anywhere on your computer,
such as your email. Paste does not clear what is in the
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clipboard. This means you can paste the same text
over and over.
You can also cut/copy and paste using the keyboard
commands Ctrl+X (cut), C (copy), and V (paste) on
your keyboard, or the right clicker on the mouse.
Simple “cut and paste” also works across documents,
and it also works across programs. However, if you
use “Paste Special” (on the Edit menu), you will find
all sorts of options about how you want to paste your
item, including a command to “link” to the original, so
that if the original changes, so does the copy you’ve
pasted.
For example, supposed you have a budget in Excel
that you would like to incorporate into your Word
document (say, for an annual report). If you have Excel on your screen, you can highlight the budget and
use the same buttons as in Word to copy the content.
Then switch screens to Word (easily done by minimizing Excel), and position your cursor within your document where you want the budget to be.
You could then use Paste to insert the Excel content
into the Word document. However, if you do, you’ll
find that Word converts it to a Word table, which usually messes up the format, and stops any calculations
or formulas from working.
You might find a better solution by using the
dropdown for Paste (on the clipboard button), where
you’ll find an option called Paste Special:

keeps the Excel formatting). Second is to tell Word
you want to use a “Paste Link.” This ties the Worksheet Object back to Excel, so that if you have to go
back to Excel and make changes, Word updates automatically. (The Word document does not need to be
open, nor does the Excel spreadsheet, to trigger the
update. Just be careful about emailing a copy of the
document, because if the Excel spreadsheet isn’t included, it can’t be updated.)
Tip: Another way to move text is to highlight it, release the mouse, then click and drag the highlighted
area. With the text highlighted, point your mouse at
the middle of the highlighted area, click (don't let go
of the mouse button), and pull the text to the new
spot where you want it relocated. This is called “drag
and drop.”

4 Kinds of Document Formats
Here’s a secret many people don’t realize: Word is
hard. Most people use Word like a typewriter, and
don’t really understand how to use it at all. Word is
hard because it isn’t intuitive. There is a logic to how
Word works, but it isn’t always apparent.
To understand Word correctly, you need to understand that there are basically four kinds of formats in
Word, and each one works a bit differently.

1. Font Formats
The most basic format option is referred to as Font
formatting, and involves all the Ribbon options for
“Font.” Font formats can be used in three different
ways:
•
•
•
Almost all Microsoft programs have a Paste Special
command. In Word, you might want to consider two
options. First is to tell Word that you are pasting a
“Microsoft Excel Worksheet Object,” which preserves
the pasted content as an Excel format (that way, it
6

Cursor position—Turn it on, type it in, turn it
off.
Highlight—Select an area of text and apply
the format.
Automatic word select—Click in the middle
of a word, and apply the format.

If you are typing, at any point as you type you can turn
on a Font format (such as underline), continue typing,
and that format will be applied until you either turn it
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off or move to a different location. But if you have already typed up your text and then want to underline
it, you must do a highlight (click, hold, and drag to select the text to be formatted).
Many people don’t realize that Font formats can also
be applied to words, just by clicking in them. It won’t
work if your cursor is at the beginning or at the end of
a word, but if it is within the word, then you can automatically format the entire word. This example
shows the word “Here” with bold, underline, size, and
text effects applied—note there is no highlight, just a
cursor on the word.

Every time you press enter (return) you are defining a
paragraph.

3. Document Formats
Every time you press the spacebar, you are marking a
word.

2. Paragraph Formats
The second level of formatting in Microsoft Word applies to paragraphs. Paragraph formats include commands such as spacing, alignment (left, right, center),
indents, bullets and numbers, and tabs; these commands apply to entire paragraphs, regardless of what
is highlighted or selected.

The third level of Microsoft Word formatting changes
the document. It doesn’t matter where you are or
what is selected, these are document commands. The
list of included formats is short:
•
•
•
•
•
•

Paper size
Paper orientation (landscape, portrait)
Margins (top, bottom, left, right)
Page numbers, headers, footers
Columns
Themes (design, color scheme, font scheme,
effects)

Document formats can be applied or changed at any
point while working within a file.
But what if you don’t want to change the entire document?

4. Section Formats
Here is an example of a paragraph (beginning “On the
Review tab”), where the last two words were highlighted, then formats for bullets, indents, and doublespacing were applied. These are all samples of Paragraph formats, which ignore the two highlighted
words and instead format the entire paragraph.

The final level of formatting controls the same options as level 3 Document Formats (margins, paper
size, etc.), but it allows you to changes parts of the
document rather than the entire document. But first,
you must divide your document into what Word calls
sections.

Here is another example. This time, note that the
highlighted area (in gray) begins on the last word
(“random.”) of one paragraph, includes all of another
paragraph, and picks up on word (“Word”) of a third
paragraph. Once highlighted, formats for spacing, indents, and center were turned on—note that all three
paragraphs (pink area) are formatted.

Sections are located on the Ribbon under the Page
Layout tab, on the button called Breaks. There are
many kinds of breaks, including page breaks (start a
new page), column breaks (when working with multiple columns), text wrapping breaks (line breaks), and
section breaks.

7
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Here is an example of a page that uses four breaks.
Near the top (yellow) is a section break; the top section (section 1) has different margins. Section 2 is in
two columns, with a column break at the end of the
first column, and another section break at the end of
the second column. Section 3 is back to normal margins, one column. Both section breaks are “continuous.” At the bottom of the page is a page break.

There are four kinds of section breaks, called Next
Page, Continuous, Even Page, and Odd Page. Do you
want your section to start on the next page, continue
on the same page, or start on the next even- or oddnumbered page?

TIP: The key to Microsoft Word is always work with your Show/Hide
button (see the Paragraph section of the
Home tab) turned on when formatting a document. It is the only way to know where tabs (→), words (·), paragraphs
(¶), sections and other breaks are located.

8
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Working with Paragraph Formats
Everyone who uses Word for more than five minutes quickly figures out the Font formats. Once you know about
Document/Section formats, the only trick becomes knowing where to position your section break for the correct
result. But the paragraph formats get people into trouble.

Bullets and Numbering
At the beginning of the Paragraph section are three buttons for bullets, numbering, and outlining. You can either
click on the button to turn on the format, or you can use the dropdown arrow to define your own format.
Defining your own bullet lets you select from symbols (from the symbol font), pictures (Microsoft graphical bullets),
or fonts (different fonts have different shapes available, such as in Webdings and Wingdings, where you find
).
Defining a custom number or outline allows you to select a numbering system and specify indents and position.
If you want to separate your bulleted items with a blank space, use the Spacing button (on the dropdown), and add
space before or after each paragraph.

Indents and Alignment
The “Increase Indent” shifts your paragraph to the right, based on your tab stop positions (see Tabs, below). The
“Decrease Indent” moves it back to the left. Since both of these button work only on the left edge of the paragraph,
you might need to know about the ruler to control the indent from the right edge (in case of a paragraph that needs
to be indented from both sides).
The alignment buttons are for let, center, right, and justify. Left goes from left to right, right lines up from the right
edge but not the left, center puts it in the middle, and justify aligns at both sides. If you opt to use justify, you might
also want to turn on hyphenation (under Page Setup) to avoid getting big gaps between words.

Spacing
There are two kinds of spacing in Word: line spacing and paragraph spacing. Line spacing is the distance from one
line to the next line. Paragraph spacing is the distance between paragraph (determined by when you hit enter), and
can be positioned before the paragraph, after the paragraph, or both (for doubled spacing).
Line spacing can be set to single (1.0), double (2.0), space and a half (1.5), triple (3), or other custom spacing. “Line
spacing options” brings up the Paragraph dialog window, where spacing is in the lower right corner. The dropdown
provides additional controls:
•

•

At least—A minimal distance between lines, set in increments of points (pts). If you set “at least” to 12 pts,
if you use 18 point type, your spacing will be larger (20) so your letters don’t touch. But if you use 6 point
type, your spacing will still be 12. In other words, the spacing distance won’t go below 12, but will increase
if needed.
Exactly—A specific point value, which won’t change regardless of your font size. If you set your spacing to
exactly 12 pts, and your type size is 18, the tops and bottoms of your letters will run into each other.
9
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•

Multiple—Something other than standard 1, 1.5, 2, or 3 (set in lines, not points).

TIP: Remember that almost all computer programs measure type in “points.” There are 72 points per inch. So 1 point
is 1/72nd of an inch. A “standard” line is 12 points.

Fills and Borders
Borders put lines around paragraphs. Fills put shades or colors into paragraphs. With both buttons, at the bottom of
the dropdown are additional options, for more colors or more line styles.
The important thing to understand about colors in a Microsoft product is that they work in RGB—red, green, and
blue. These are not the primary colors (red, green, yellow are primary). Rather, they are parts of the spectrum,
rainbow colors (red, orange, yellow, green, blue, indigo, and violet); combine them all to get white.
RGB colors are set in numerical values, which are useful to remember when trying to work with branding (“themes”).
Every color has a specific numerical value. For example, Northwestern University purple is r 82, g 0, b 99.

Other Paragraph Settings
There are two other sets of paragraph settings that are very critical to know about. When you click on the tiny corner
dropdown for the Paragraph section, you’ll get a dialog window. In the lower left corner is a button to take you to
Tabs. This is where you set and clear tabs (see below for more detail about setting tabs).
This window actually has two tabs at the top. The second tab is called “Line and Page Breaks.” Clicking it brings up
some useful options:
•
•
•
•

Widow/orphan control (default is on)—Widows and orphans are paragraph stragglers at the top or bottom
of pages (one line that carries over), and are considered “bad” stylistically.
Keep lines together—Don’t let a paragraph split across two pages.
Keep with next—Keep the current paragraph with the following paragraph. If the next paragraph moves to
the next page, keep this paragraph with it (useful for keeping headings with their following text).
Page break before—Force this paragraph to a new page, regardless of its current position.

Remember that all of these are paragraph commands, and impact the entire paragraph (not just a highlighted area).

Using the Ruler
One of the most useful—and confusing—features in Microsoft Word is the ruler (activate it on View tab). The ruler
spans the top of your page and down the left side, and is useful for controlling margins, indents, and tabs. (Remember that margins are a document/section format, but indents and tabs control paragraphs.)
•
•

Right Paragraph Indent—The right triangle controls the right margin of the selected paragraph.
Right Margin—The right edge (where the white meets the gray on
the ruler, above the house-shape) controls the right margin of the
entire document (or section).
10
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•
•
•
•

Left Paragraph Indent—The square box at the left indents the paragraph. When you drag it, all parts of the
left move.
Paragraph Indent—Above the square box is a triangle (like the roof on a house), which indents the entire
paragraph except for the first line.
First-Line Indent—At the top of the ruler (above the left house shape) is a downward pointing arrow, which
indents only the first line of the paragraph (including bullets and numbers, useful for setting up “hanging
indents”).
Left Margin—When the pointer sits between the first-line indent
and paragraph indent triangles, it becomes a double-arrow for
changing the margin of the entire document or section. Measure the
margin by watching the number in the gray area, not the white
area.

Tabs
Tabs are the best way to make text line up at specific positions on the page, such as for forms or for decimal alignment (remember the rule that on computers your spacebar never works to line text up). Tabs are most easily controlled from the ruler (although they are also available on the Paragraph section dropdown).
At the left edge of the ruler is a small box that contains an L. This is the tab set button. To set tabs, first click on which
kind of tab you would like: Left, Center, Right, Decimal, or Bar (for vertical bar lines). Then click on the ruler with
your mouse where you want to position the tab. If you don't like where it is, pull it with your mouse to a different
location. If you want to remove it, click and pull it off the ruler.
Remember the left, right, and center have nothing to do with your margins. Here is a sample of how you could use
the different tabs:
[center]
Date
Monday
Tuesday
Wednesday
Thursday
Friday

[right]
City
Chicago
Atlanta
Los Angeles
New York
Boston

[left]
State
IL
GA
CA
NY
MA

[decimal]
Number
6.5
14.7
1.1
17.3
123.4

The first column is centered. The second aligns on the right, and the third on the left. The fourth aligns on the decimal
point (including the heading, which doesn’t have a decimal, so looks “off”). Remember that each line is actually a
paragraph (there is an enter or return after each), so changing one has no impact on the others; if you want to
change them all, you must highlight the multiple paragraphs.
Since you press enter at the end of each line (start a new paragraph), you carry your tab settings with you to the
next line. If you arrow up or down to a new paragraph (or click on a new paragraph), you leave the tab settings.
Under the “Paragraph” tab’s dropdown is a Tab button that provides additional options, such as for dot leaders and
underlines, as well as “clear all.”
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Dot Leaders:
Title ................................................................................................... Page
Using Word ............................................................................................ 1
Mastering Excel ................................................................................... 84
PowerPoint Essentials........................................................................ 127
Underscore Leaders:
Name ____________________________________________________
Address___________________________________________________
City, State Zip ______________________________________________

Tables
Tables are another way to work with columns and to align text and numbers. They are created by clicking and dragging the Table button on the Insert tab on the Ribbon.

This creates a series of “cells” that can contain text or numbers, much like Excel. If you wish to adjust the size of a
column, you can pull the on-screen borders. Tabbing adds rows to the table.
Note that when you have a table, an additional Ribbon tab called “Table Tools” appears, with table “Design” and
“Layout,” where you will find many commands for position, size, split/merge cells, and much more. Tables can also
be used to “sum” columns of numbers (Sum and other simple functions are on the
button for formulas on the
Ribbon button called “Table Tools/Layout”). Table cells can also be used to sort and to rotate text.
Item
New computers
Software
Internet
TOTAL

Cost

1,299.37
2,738.88
720.00
4,758.25

In this example, the table uses one of the standard designs on the Ribbon. The headings are then center aligned. The
numbers are aligned with a decimal tab. The total row was heightened by dragging the bottom border, and then the
text was lined at the bottom (with the Layout Alignment buttons). And the total cost was calculated with the formula
=sum(above).

Columns (“Page Layout”)
This button separates document into multiple, newspaper-style columns. The “More Columns” menu on the
dropdown includes options for margins and adding a line between columns. To put columns into part of a document,
the document must be divided into “sections” with “continuous” breaks (see below for more details).

12
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Working with Styles
Styles are saved formats that can be re-used. The important thing to know about styles is that Word uses them
whether you do or not, and many functions in Word (such as Table of Contents) will not work without styles. Every
feature of Word has an assigned style, such as page numbers, headers and footers, footnotes and endnotes, and
envelopes and labels. When you start a new document, you are already using a style called “Normal.”
Styles can be edited. It is important to understand in Word that if you do not like what a style is doing to your text,
don’t change the text—change the style!
On the Home Ribbon, the button called “Styles” expands the styles screen into a drop down. Hover over any to get
a description.
At the bottom of the Styles window are three commands. One creates new styles and adds them to the list. The
second is the style inspector, which will let you modify your styles. The third is manage your styles, which lets you
remove styles.

Editing Styles and New Styles
Since styles are ways to store your formats for re-use, you can either create new styles or edit (“modify”) existing
styles (you can also highlight an area of text with a desired format, then click on the style box to get a menu to
“redefine” the style on the highlighted text).
•

New Style—Requires you to specify a name (which shows on the format toolbar); a style type (change the paragraph or just the highlighted area); based on (used other style as base format); and style following paragraph
(the next style to switch to when you hit enter). Then you change the format.
• Modify Style—Change an existing style. The format option gives you choices to change
 Font—allows you to specify font, font size, color, position (super/subscript), characteristics (bold, italics,
small caps, underline, etc.), and spacing (normal, expanded, or condensed).
 Paragraph—formats specify paragraph alignment (left, center, right, justified), indents (left, right, first line),
spacing (before or after, or between lines), based on style, border (box or bar), keep together, page break
before, and line numbering
 Tabs—tab settings for the style
 Borders—sets borders and shades around the paragraph
 Language—codes text so Word will use different language spell checkers
 Frame—creates “cutouts”
 Numbering—automatic numbers
 Shortcut key (assign an keyboard combination to run the style, such as Ctrl+Sh+I)

Unless otherwise specified, styles are paragraph formats, and automatically affect the entire paragraph.
The automatic setting is that a style is available only in the document on which you are working. If you wish to make
a style available in other documents, you must add it to a template (check box in the modify window); then you will
have access to it any time you are working on a document that is based on that template.

Changing Your Default Formats
To change your automatic (default) type format in Word, use “Styles” to redefine your “normal” style. Be sure to
check “New Documents based on This Template” so it is saved. Remember each template has its own styles.
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Reveal Formatting
On the Ribbon’s pull-down for Styles is an option called “Styles Inspector.” There you’ll find an option called “Reveal
Formatting.” This screen shows you the formats currently being used for whatever text you have clicked on. They
are separated into the big three categories: font, paragraph, and section.

Tricky Section Commands
Columns (“Page Layout”)
This button separates document into multiple, newspaper-style columns. The “More Columns” menu on the columns’ dropdown includes options for margins and adding a line between columns. To put columns into part of a
document, the document must be divided into “sections” with “continuous” breaks.

Headers and Footers (“Insert”)
Headers go at the top of pages, and can contain text, date, page number, and rule line. Footers go at the bottom.
Two page number tabs are already set for centering and flush right. (Important: Remember that headers, footers,
and page numbers are controlled by section breaks.) The Ribbon options for this function have the following choices:
1.
2.
3.
4.

Built-in (pre-set formats)
Edit header
Remove header
Save selection to header gallery

The “Insert/Page Numbers” dropdown allows you to choose a number location (top or bottom, margins, or cursor
position), and left, right, center—and whether or not to show the number on the first page. Also in this window is a
“Format” button, which allows you to tell Word to continue numbering a particular section consecutively from the
previous section or to start re-numbering the current section from a particular number within the document (useful
when you have a cover page, table of contents, then want the third page to be numbered page one).

Renumbering Within a Document
Suppose you want to skip a number in the middle of a document, or you have a cover page and table of contents,
so you need start numbering with page #1 on the actual page 3. To vary page numbering within a document, you
must do two steps:
1.
2.

Separate the pages to be numbered differently into sections (“Page Layout/Breaks”)
Create a header/footer (under “View”) in the section to be numbered that has the button called “Same as previous” turned off.

There are 3 kinds of breaks: (1) Page breaks, (2) Column breaks, and (3) Section breaks. Only the section break will
work for re-numbering. Sections can be inserted as a “break to next page,” “break to next odd numbered/even
numbered page,” or “continuous” (stay on same page). Generally, this function is easier to control and manipulate
if you can put the section in as a “next page” break. Then, with your cursor in section 2, go to “View/Headers-Footers.” A new toolbar will appear.
The button to watch out for is third from the end: “Same as previous.” If this is turned on, it keeps each section
consistent (that is, if you turn on page numbering in section 2 on page 3, it will also turn on for section 1 on pages 1
and 2). Once you have turned off “Same as previous,” you can either insert the page number wherever you want it
to go by using the toolbar’s # button or by “Insert/Page number.” Either way, you will get the number 3 on the third
page. Since you want this page to be numbered one, go to “Page Number Format” (on the toolbar or menu) and tell
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it (at the bottom) to start counting at number 1. Page 3 (section 2) will now be numbered 1; page 4 (section 2) will
be numbered 2; etc.
Let’s assume that your page number should begin on page three of the document, with the number “1” on page
three. Go to the bottom of page 2, then go to “Insert/Break” to locate the section command. Repeat on page 4. This
creates 3 sections.

Let us assume page 5 should not be numbered. Put in a section break (either next page or continuous) at the bottom
of page 4. Go to page 5 (section 3) and double-click the header. The header toolbar appears; turn off “Same as
previous.” Then delete the page number.
Page 6 should be numbered 4. Put in a section on page 5 (unnumbered page), then go to page 6 (section 4), doubleclick the header area, turn off “Same as previous,” then insert your new page number. Go to “Page Number Format”
to tell it to start counting with page number 4. Continue as needed.

Shortcuts
AutoCorrect
On the “File/Options” command is a feature called
Proofing/AutoCorrect Options. This function automatically corrects typos when you make them. Although many typos are built in to Word (such as “adn”
to “and”), you can tell it your favorites. There are two
steps: enter the text you wish to have replaced, and
then enter what you want to replace it with. Then you
“add” your entry.
Under AutoCorrect Options are many other features
that many Word users find annoying. AutoCorrect is
where you turn off features such as automatic capitalization at the beginning of sentences, or set first
and left indent with tabs and indents.

Insert
•
•
•

Cover Page—Insert or remove pre-formatted
cover pages at the beginning of your document.
Blank Page—Insert a new page at your current
cursor position.
Page Break—Manually start a new page.
15
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•
•
•
•
•
•

•
•

Table—Insert table (columns and rows).
Illustrations—Pictures, clipart, etc. (see below).
Links—Hyperlinks, bookmarks, cross-reference.
Header & Footer— Specify position and alignment for automatic numbering. (See below for
more detail.)
Text—Text box, Quick Parts, WordArt, Drop Cap.
Date and Time—Inserts the current date and/or
time at your cursor position. At the bottom of the
window is an option you can turn on or off that
will insert the date or time as an automatic “update field.” This tells Word to update the date
whenever you next work on this document; you
will still see the old date on the screen, but the
current date will print.
Equation—Mathematical notation.
Symbol—Special
characters,
such
as
½. Note that each character can
be assigned to a keyboard shortcut (such as
Ctrl+Alt+a). Symbols differ depending on the font
selected. The fonts called Symbols and Wingdings give you the most options. Under “Special
characters” you’ll find symbols such as §©®¶….
Any of these can be assigned to a shortcut key.

Page Layout
•
•
•
•
•

Themes—Colors, fonts, and designs.
Page Setup—Margins, Size, Columns, Breaks
(sections)
Page Background—Watermarks, color, borders.
Paragraph—Indents and spacing.
Arrange—Front to back, align, text wrap (for objects such as pictures).

Quick Parts
On the “Insert” tab is a drop-down box for Quick
Parts. This option gives you “building blocks,” or parts
of a document that are predesigned so you can simply
pick one and insert it, then edit it to your desired look.
What is especially useful about Quick Parts is the ability to store your own elements. Simply highlight any
content in a document that you would like to have remembered. Then click on Quick Parts and choose
“Save Selection to Quick Parts Gallery.” This puts your
entry onto the Quick Parts dropdown.
To insert your custom Quick Part, just click the dropdown and select your entry. It is inserted wherever
your cursor is positioned. (Note: After adding an item
to Quick Parts, you will be prompted to save it the
next time you exit Word; be sure to answer “yes” if
you want to keep the entry for future use.)

Format painter (“Home”)
Copies a format from highlighted text, then pastes it
to another highlighted area. To use the painter, first
highlight the text whose format you want to copy;
then click the painter button. Next, scroll to the area
of text that you want to re-format in the new style,
and highlight it. This stops the painter (it will only do
one selected area at a time; you must re-click the
painter to do a second area).

Drop cap (“Insert”)
Enlarge the first letter of a paragraph and wrap text
around it. Note that this function will not work with
tabs before the letter since it “frames” the first space
on the line.

References
•

Cross-Reference—Table of Contents—Label highlighted text for inclusion in a table of contents,
then generate the table, with page numbers.
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•
•
•

•
•

Footnotes—Insert footnotes or endnotes.
Citations and Bibliography
Captions—Cross-references (allows you to insert
a link in your text to another page, heading, footnote, or table, so that if the target changes (for
example, page 3 may be page 4 or 5 when you’re
done), the reference updates automatically).
Index—Alphabetical list of key words.
Table of Authorities—Legal cites.

If you do not like the format Word applies to the results, do not try to format manually. Since these “tables” and “indices” are automatically updated (i.e.,
page numbers change whenever your text changes),
be sure to make format changes through “Style” using
the appropriate styles.

Generating a Table of Contents
Tables of Contents are based on “styles” applied to
text by using the Style dropdown (in Word 03 or 07)
or the References “Add Text” command.
To define an entry for your table of contents, click on
the heading, then select Heading 1, 2, 3 (etc.) to specify the level heading; this will determine the indentation and position of your entry in the contents. There
are formats already in place for each heading, which
are usually not what you need. Use the Style
dropdown to “modify” your heading formats so they
look correct.
When all headings have been “marked” as such, use
the Table of Contents command (References on the
Ribbon tabs) to generate the table. It will be inserted
wherever your cursor is within the document. Note
that the resulting contents list (with page numbers) is
not editable; it turns gray if you click within it, which
is Word’s way of telling you not to try to make
changes. If you wish to make the content editable,
you can do so by highlighting, cutting, and then using
“paste special” to put it back as unformatted text (of
course, it will no longer automatically update).
If you do not like the format Word applies to the table
content, do not try to format the table manually.
Since these “tables” automatically update (i.e.,
printed page numbers change whenever your text
changes), be sure to make format changes through
“Style” using the appropriate styles (such as TofC 1).
Click on any part of the table to display the name of
the style in use, then use Style/Modify to make your
changes (use “add to template” if you want these
changes to be remembered and used as defaults.)

Generating a Table of Authorities
Marking citations for a table of authorities is comparable to manually marking headings for a table of contents. Word looks for cases, statutes, rules, treatises,
and constitutional provisions to generate a table of
authorities. You can also mark any additional authority you need included.
Step 1: Type your legal document, including all the
cases, statutes, rulings, treatises, regulations, and
Constitutional provisions that you will cite. You may
either mark the citations as you type, or finish the paper and then go back through it, marking the citations
at the end.
Step 2: Mark your citations. Highlight the citation that
you wish to mark. In Word 03, choose "Insert" on the
menu bar. Navigate down to "Reference" and click on
"Index and Tables." (In Word 07, go straight to References.) Choose the "Table of Authorities" tab at the
top of the dialog box. Click on the "Mark Citation" button. Choose the category of your citation from the
drop-down list (e.g., case, ruling, regulation) and click
"Mark" or "Mark All" (depending on whether you
want to include all references to this particular citation in the table of authorities or just one instance).
The following dialog box will appear. Click Next Citation. Word searches the document for terms such as:
in re, v., Id., Supra, Infra, Cong., Sess., and §.
Step 3: Click the "Next Citation" button at the top of
the dialog box. Microsoft Word searches for common
legalese such as "v." and dates in parentheses
"(1950)." Mark each citation as appropriate. Click the
"Close" button to return to your document. You may
want to do a manual scan of the document to ensure
Word correctly picked up all your legal citations.
Step 4: Move your cursor to the point in your document where you wish the table of authorities to appear. In Word 03, choose "Insert" on the menu bar,
and navigate to "Reference" (go straight to References in Word 07) and click on "Index and Tables."
Choose the "Table of Authorities" tab at the top of the
dialog box (or “Insert TofA” in 07). Make sure the Category type is set to "All" if you wish your table to include all types of legal citations. Press "OK." Word creates a table of authorities using all your marked citations, organized by citation type.
A note about “passim”: If checked and a citation is referenced on more than 5 pages, Word will put the
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word "passim" in place of the page numbers. If unchecked, Word allows all referenced pages to be
listed, no matter how many there are.

Advanced Commands
Track Changes (“Review”)
“Track changes” is the instruction for Word to retain
all editorial and formatting changes to a document.
Text you delete will be struck-through (deleted); new
text that is inserted is underlined; both text will be
red. (Note, on the dropdown for Track Changes, there
are “options,” which will switch revisions into “balloons” that display and print in the margin, rather
than in the body.)
If you wish to see what the final version looks like,
change the dropdown for “Final: Show Markup” to
just “Final.” You can also set it to show the “Original.”
However it is very important to understand that setting it to “Final” does not eliminate the tracked
changes, so that if you email your document to someone, they can still see all your revisions.
It is essential to “Accept” or “Reject” changes if you
wish to eliminate them from the document (so others
can’t see them).
Word Tip: If you frequently turn Track Changes on
and off, be sure to put it on your status bar at the bottom, so you can toggle it with a click.

Themes
Themes control the “look” of your document (they
work in Word, Excel, PowerPoint, and Access). Builtin themes create a “Theme Design,” identified by a
name, such as “Office” or “Facet.” You can, of course,
create your own themes, which becomes an important step of “branding” (creating your look).
There are three parts to a theme design, each identified by the same name as the overall design:
•
•

Colors—Selects the colors that become used in
all text, fills, backgrounds, charts, shapes, etc.
Fonts—Defines the default or built-in font for an
entire document.
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•

Effects—Picks particular design effects (such as
drop-shadows or bevels or glows) that are used
by Excel’s building choices.

On each item’s dropdown (on the Design tab) is the
“Customize” option, which lets you create your own.
If you save your customized choices, they are then
added to the Themes list for future use, and they also
become available in all Microsoft Office programs.

Graphics
On the Insert tab of the Ribbon, Word gives you commands to insert
• Pictures—photographs inserted from files, which
can then be sized and formatted in various ways.
• Online Pictures/Clip Art—free artwork from Microsoft, including cartoon, animations, photographs, and sounds, most on-line (must be downloaded to use)
• Shapes—graphical shapes (such as stars and
boxes) which can be used to hold text
• SmartArt—specially designed graphical displays
for showing lists, processes, hierarchies (such as
organization charts)
• Charts—graphs based on data, entered into Excel, but embedded in Word.
• Screenshots—screen “grabs” from other windows currently open, which are then inserted
into your current document.
Once you have inserted any graphic, you can then edit
with tabs that appear for Picture Tools.
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SmartArt
SmartArt is a new way to present information in a visually appealing way (I hope), without resorting to
bland bullets or boring lists. It works consistently
across Word, Excel, and PowerPoint. You begin by using the Insert tab on the ribbon, where you find
SmartArt listed in the Illustrations group. Clicking it
brings up a selection of SmartArt types, including List,
Process, Cycle, Hierarchy, Relationship, Matrix, and
Pyramid, each with a variety of formats. Select one to
insert the SmartArt into your document. This adds
two new tabs to the ribbon: Design and Format.
At the left of the SmartArt is a text-typing area which
can be closed (X in the corner) or opened (double-arrows on frame). Press enter to create a new level;
press Tab to indent or create a sub-bullet. When formatting and designing, note that many of the selections can be “previewed” by pointing your mouse at
the option (but don’t click).

Manipulating SmartArt
Selecting: To manipulate a SmartArt object, you first
select or highlight it. To do this, simply place
your pointer anywhere in the graphic and
click once. Graphical “handles” should appear on the edges.
Moving: With the object active, point the mouse at
the frame or border outlining the graphic,
then click and drag, moving the mouse, and
the chart moves with you.
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Resizing: To enlarge, shrink or change the shape of
the object, place the pointer on any of the
“handles” on the frame until the pointer’s
shape changes into double-arrows, then
click and drag. The outline you draw will
change the chart accordingly. Corner handles enlarge and shrink. Many of the components of a SmartArt object also have handles, which can be stretched and pulled to
re-size that part of the graphic.
Formatting: Clicking once on a SmartArt object will allow you to move it or change its dimensions.
But you may want to change other aspects
as well. One option is to click once on any
specific part of the chart, then right-click
with your mouse to find “change” and “format” options. Alternatively, you can use the
ribbon tabs, as explained below. Remember
to click the Home tab for simple formats
(font, size, center, color).
Deselecting: After completing your changes, simply
“Click Away” – click any where in the document outside the object.

SmartArt Styles
•
•

Reset

Cancels any formatting changes you have
made and restores the SmartArt object to
the original format.

Format
Shapes

Impacts the shapes within a SmartArt object.
You can change the shape (switch a box to
an arrow), or make the shape larger or
smaller.

Shape Styles

Predesigned or custom fills, outlines, and effects for the components of the graphic
(such as fill colors or borders or shadows).

Design
Create Graphic
•

•
•
•
•

•

Add Shape — Opens the dialog window that
allows you to select the kind of chart you
wish to have (column, line, pie, bar, area, XY,
stock, surface, doughnut, bubble, radar).
There are multiple designs for each chart
type; for example, for column charts, there
are side-by-side, stacked, percentile, and
front-to-back.
Add Bullet — Adds either another entry of
the same level within the hierarchy, or a
sublevel.
Right to Left — Aligns content on the right
instead of the left..
Layout — Saves an edited chart as a template, so it can be re-used.
Promote/Demote — Indents and unindents
bullets and levels (same as Tab and ShiftTab). Turns a main level entry into a subentry, or a subentry into a main entry.
Text Pane — Activates the text-typing box.

Word Art Styles

Predesigned or custom text formats (including color, border, and effects such as glow).

Arrange

Bring to front or send to back (used when
there are multiple objects).

Size

Layouts

This option allows you to switch from one
SmartArt design into a different one, for example, from 3 horizontal boxes to 3 vertical
boxes or to a pyramid.
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Change Colors — Select new color combinations (based on Theme colors) for the conte.t
Effects — Various designs you can select to
create 3-dimensional or shaded effects (note
this is one of the features where you can preview by pointing your mouse at an option
without clicking).
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The horizontal and vertical dimensions of
your chart. This is an alternative way of sizing, as opposed to dragging handles.

Templates
Just as there is never a time in Word when you are not
in a style, the same is true of Templates. Templates
are pre-formatted documents that can be re-used.
They hold paper size, margins, headers/footers/page
numbers, columns, and styles. Any time you select a
template, you automatically get a new document.
Word supplies a large variety of built-in templates.
You activate them by using the “New” command on
the Office Button. Choosing a template creates a new,
unnamed copy of the original’s content on your
screen (which many people erroneously try to do by
using “Save as”).
To make your own templates, create a document. Instead of saving it as a document, when you press
Save, change the file type to read “Word template.”

Envelopes and Labels
If you need to print an envelope or label as part of a
letter, you do not have to highlight the address unless
there is more than one. Go to “Mailings/Envelopes
and Labels.”
Under Envelopes, you will have a dialogue box that
should automatically show the mailing address from
the letter. There is an optional return address that can
be omitted by clicking the “omit” box. There is also an
address book for storing and re-using addresses if Microsoft Outlook is installed on your system.
Under Envelope/Options, you can specify what size
envelope to print, and what font and position to use
for the addresses. Then you can decide whether to
print the envelope straight to the printer, or add it to
the letter to save it for future use.
The Label window is very similar. However, at the bottom of the window are two other options: print a full
page of the same address (a sheet of labels to the
same person), or print one label on the page (to reuse a partially used set of labels, which requires you
to specify which column and row on the sheet to use).
You can specify the label format through the Options
button.
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If you want to print multiple labels, but to different
addresses, you can trick Word into creating a label
document. Leave the address box empty, and select
the option for “New Document.” This creates a sheet
of labels. Use your tab key to move between labels,
and at the last label, use the tab key to start a new
page (if you need more).

Mail Merge
Mail merge is the ability to generate multiple letters,
envelopes, labels, or emails, or to generate a “directory” from one list of data. To start a mail merge, go
to the Mailing ribbon, and click on “Start Mail Merge.”
The mail merge task pane will appear on the right side
of your screen. There is also the “merge toolbar”
across the top of your screen.
Mail merge is a “wizard”; there are 6 steps to complete the merge. Step 1 is to select the type of document you are trying to create: letters, email, envelopes, labels, directory (a directory used to be called
“catalog” and compiles a formatted list from the
data). Select the one you wish to do; you can only do
one at a time (radio button). Then click at the bottom
where the screen reads “Next: Starting document.”
Step 2 is “Select a document.” You can use the current
document (whatever is currently on your screen), use
a pre-existing template, or choose a different existing
document (open a file). Select one, then click on
“Next: Select recipients.”
Step 3 is where you specify where your data are coming from. You can use an existing list (click on
“Browse” to locate a preexisting list, as long as it is
either a database .MDB file, an Excel .xls file, a Word
.doc file, or a delimited .txt file), select from an Outlook address book (“Choose Contacts Folder”), or
type a new list (“Create”). If you click “Create,” you
will see a data entry screen where you can type your
information; this screen is designed to match the
other steps of the wizard; if you choose not to use this
form (you use “customize”) or if your data already exist from another source, you will need to do the
“Match fields” in a later step.

Once your data are entered and saved, you are given
an option to “select” recipients. This screen appears
(it also appears when you click “Edit recipient list”),
with check boxes next to each entry for selection. You
can also click any column heading to sort (ascending
or descending). You can also use the pull-down arrow
next to each column heading to filter specific content
or to go to “Advanced” querying or filter options and
multiple level sort.

various letters to see if you are satisfied; there is also
a button to edit the recipient list and another to exclude a particular recipient.
Step 4 is “Write your
letter.” Even if your
letter already exists,
this step is where you
place your fields onto
the page for the actual merge. There are
pre-designed recipient information fields
ready to use, based
on the form screen:
address block, greeting line, electronic
postage, and more (individual fields). If your fields
have not changed, you can simply select the position
in your document, then click the appropriate field
code to put that information in.
If your fields are different, then you need to re-define
the list of items. If you click “Address block,” for example, you will see how it is created and what it contains. In the bottom corner is the button for “match
fields,” which allows you to coordinate your own field
names with the built-in fields.
Once you have designed your letter, you are then
ready for Step 5, “Preview your letters.” Previewing
gives you’re a navigation tool (<< or >>) for looking at
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The final step, Step 6, is to complete the merge. You
can either send your merged output to the printer, or
select the choice called “Edit individual letters.” This
puts the letters on your screen so you can look them
over, revise and customize, and then print.

Merge to Envelopes and Labels
Merging to envelopes and labels follows essentially
the same steps as for a letter. For an envelope, you
have the optional step of designing your envelope
(where do you want the address and return address
to be, and what font and size should they be).
For labels, you have “Label options” where you can
select which label size (including name tags and postcards) to print to. The only part that is different for
labels is in Step 4, where you must do a step called
“Replicate labels” (or “Propagate” on the toolbar).
When you design one label with your fields, you need
to take that same design information and place it on
all the other labels for the page. This is accomplished
by clicking “Update all labels.” If you forget to do this
step, you will end up with only one label.

Word Shortcuts
Alphanumeric Keypad Moves

Control (Command) Key Shortcuts

Home — Move to beginning of line
End — Move to end of line
Control+Home — Move to beginning of document
Control+End — Move to end of document
Arrow Keys — Move character-by-character or line-by-line
Control-Arrow — Move word-by-word (left, right) or paragraph (up, down)
Page Up/Down—Move screen by screen
Paragraph Breaks — Enter
Page Breaks — Ctrl-Enter
Column Breaks — Ctrl-Shift-Enter
Line Breaks (same paragraph) — Shift-Enter
Hard Spaces — Ctrl-Spacebar (non-breaking spaces)
Alt — Ribbon keystrokes
F1 — Help
F2 — Move highlighted text
F5 — Go to
F10 — Ribbon keystrokes (same as Alt)
F12 — Save As
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a
b
c
d
e
f
g
h
i
j
k
l
m
n
o
p
q
r
s
t
u
v
w
x
y
z
Shift+e
1
2
5
space
+
=
Space
Delete
Backspace

Select (highlight) all
Bold
Copy
Fonts
Center
Find
Go to
Replace
Italic
Justified left to right
Insert hyperlink
Left align
Indent
New document
Open document
Print
Redo
Right align
Save
Hanging indent
Continuous underline
Paste
Close document
Cut
Repeat
Undo
Track changes (on or off)
Single space
Double space
1.5 space
Reset to normal format
Superscript
Subscript

Discretionary hyphen (-)
[Numeric -] En-dash (–)
[Numeric - + Alt] Em-dash (—)
Nonbreaking space
Delete one word forward from cursor
Delete one word backward from cursor

